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Introduction
This booklet is the companion document to the Excel 2016: PivotTables and Pivot Charts workshop.

The booklet will explain PivotTables and Pivot Charts, how to create them, and how to use them to
quickly analyze large quantities of data.

Learning Objectives

After completing the instructions in this booklet, you will be able to:
e Define PivotTables and Pivot Charts
e Insert PivotTables
e Insert Pivot Charts
e Filter information in your PivotTable and Pivot Chart

e Use Slicers
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PivotTables

PivotTables are a powerful tool in Excel that will allow you to quickly summarize, sort, filter, and
analyze data. They can handle large amounts of data in lists and tables by organizing data, on the fly,
by different rows and columns. This is faster, and more flexible for analyzing your data, as you don’t
need to rely on formulas.

For example, you could have a spreadsheet that contains information on salespeople, products sold,
regions, items sold, etc. Using a PivotTable, you can quickly organize the data so different relationships
are visible (e.g. Who is the top salesperson? What product has sold the most?).

Salesperson Product Region |Customer Date Item Cost | No.ltems | Total Cost
Vaughn, Harlon Captain Recliner NE B&B Spaces 01/03/11| § 340.95 9|$ 3,068.55
Norman, Rita Media Armoire SE Home USA 01/03/11| S 340.95 2(S$ 68190
Christensen, Jill Bamboo End Table NW Ellington Designs [01/04/11| § 79.99 7|8 55993
Norman, Rita Bamboo Coffee Table |SE Ellington Designs |01/05/11| $ 168.95 3|8 506.85
Byrd, Asa Bamboo End Table SE B&B Spaces 01/05/11| § 79.99 12 [ S 959.88
Owen, Robert Chameleon Couch SW Ellington Designs [01/07/11| § 799.95 13 | $10,399.35
Maynard, Susan Bamboo End Table NE Home USA 01/08/11| § 79.99 10| S 799.90
Norman, Rita Chameleon Couch SE Home USA 01/08/11| § 799.95 2|$ 1,599.90
Norman, Rita Media Armoire SE Home USA 01/08/11| § 340.95 6|S 2,045.70
Norman, Rita Media Armoire SE B&B Spaces 01/11/11| S 340.95 13 | $ 4,432.35

Figure 1 - Sample Sales Spreadsheet

Note: When working with PivotTables, the data should contain your titles in a single row, and the table
should not contain any empty cells.

Creating PivotTables
The following will show you how to create a PivotTable using the sample sales spreadsheet as an

example:
1. Inthe Ribbon, Click the Insert tab.

R -

Home Page Layout Formulas Data Review View @ Tell me what you want to do...
5 | ] - 7 - le- - ]
J 3 ) lag 5 W 12 i i 1
PivotTable Recommended Table  Pictures Online -‘ My Add-i . Recommended PivatChart
- ins . L .
PivotTables Pictures i+ 7 g E Charts L RGIRR -
Tables Illustrations Add-ins Charts [}

Figure 2 - Insert Tab
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2. Under the Tables grouping, Click PivotTable.

PivotTablejRecommended Table
PivotTables

Tables

Figure 3 - PivotTable

3. The Create PivotTable window will appear. Excel will automatically select the data it thinks you
want to use to create your PivotTable.

a

Create PivotTable

Choose the data that you want to analyze

@ Select a table or range
Table/Range: | Creating!SAS4:5HS913 £

(") Use an external data source

Connection name:

Choose where you want the PivotTable report to be placed

() Existing Worksheet

Location: E’é

Choose whether you want to analyze multiple tables
[} Add this data to the Data Model

OK 1[ Cancel ]

.

Figure 4 - Create PivotTable Window

Note: To select a different range from what Excel has suggested, Click the cell selection box and use
the mouse to select a new range.

4. Under Choose where you want the PivotTable report to be placed, select New Worksheet.

Choose where you want the PivotTable report to be placed

(") Existing Worksheet
Location: E&E

Figure 5 - Create PivotTable on a New Worksheet

5. Click OK.
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6. The PivotTable will be created in a new worksheet.

| ||| PivotTable Fields =X
Chooss fisdds to add to repark: & -

Search

)=}

Salesperion
Product

To build a report, chonse
fields from the PlvatTable
Field List

Regicn

5o @ ~ o v kW
| 1 1

-
)

No

Takal Cost

|
14 = MORE TABLES ..
O

Dirag fickds bebween arzas below.

T ETERs 1l COLUMMNS

= ROWS E VALLES

» FivorTable & Pivet Chart | Sheetl o 7| e LI Defer Layond Update

Figure 6 - New PivotTable Worksheet

7. The PivotTable Fields will appear on the right side of the screen.

PivotTable Fields v
Choose fields to add to report: -
Search yel

Salesperson
Product
Region
Customer
Date

Item Cost
Mo.ltems
Total Cost

MORE TABLES...

Drag fields between areas below:

T FILTERS Il COLUMMNS

= ROWS Z VALUES

Figure 7 - PivotTable Fields
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Analyzing Data with PivotTables

After creating your PivotTable, the PivotTable Fields list will display the data ranges that you selected,
and four areas that will make up your PivotTable (Filters, Columns, Rows, and Values). You can quickly

move fields in and out of these areas to view your data in different ways.

For example, we want to use the PivotTable to analyze the data and determine how many sales a
salesperson has made of each product.

1. Drag-and-drop your fields into the filter, column, rows, and values boxes.

Filters area fields are shown as top-level report filters above the PivotTable (See Error! R
eference source not found.).
Columns area fields are shown as Column Labels at the top of the PivotTable (See Error! R
eference source not found.).
Rows area fields are shown as Row Labels on the left side of the PivotTable (See Error! R
eference source not found.).

a.

PivotTable Fields v X

Choose fields to add to report: -
Search sl
| Salesperson

| Product

+| Region

Customer

Date

Itemn Cost
+| No.Items

Total Cost

MORE TABLES...

Drag fields between areas below:

FILTERS @ COLUMNS@

Region - Product -

ROWS © VALUES @

Salesperson ¥ Sum of MNo.lte.. =

Defer Layout Update

Figure 8 - Select PivotTable Fields

Values area fields are shown as summarized numeric values in the PivotTable (See Error! R
eference source not found.).
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2. The PivotTable will change to show the fields in their respective locations, showing total sales

for each sales person by product.

Region (All) -

Sum of No.ltems |Column Labels v

Row Labels v Bm Bamboo End Table Captain Recliner Chameleon Couch Media Armoire Grand Total
Arnold, Cole 154 104 138 121 91 608
Byrd, Asa 150 69 155 101 110 585
Christensen, Jill 209 118 151 117 183 778
Kelly, Icelita 19 150 90 174 166 599
Leon, Emily 154 124 80 105 169 632
Livingston, Lynette 79 122 74 107 142 524
Lucas, John 77 130 75 172 62 516
Maynard, Susan 147 145 125 116 212 745
McCullough, Scott 93 62 72 90 121 438
Norman, Rita 134 145 79 128 172 658
Owen, Robert 157 120 150 245 170 846
Vaughn, Harlon 233 199 214 199 217 1068
Grand Total 1612 1488 1403 1679 1815 7997

Figure 9 - PivotTable Results

Filtering the PivotTable
The following shows how to filter information within a PivotTable:
1. Next to a Field Header, click the drop-down arrow.

Region Al v

Sum of No.ltems Column Labels =

Arnold, Cole 154 104
Byrd, Asa 150 69
Grand Total 304 173

138
155
293

Row Lahels ~| Bamboo Coffee Tahle Bambhoo End Tahle Captain Recliner Chameleon Couch

121
101
222

Figure 10 - Drop-Down Button
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2. A Drop-down menu will appear with values for the field listed below.

More Sort Options...

Label Filters 4
Value Filters 4
Search yel
] (Select All) -~
¥l Arnold, Cole 3l
-[¥] Byrd, Asa

V| Christensen, Jill
V] Kelly, Icelita

-[¥| Leon, Emily

-[¥] Livingston, Lynette
¥ Lucas, John

-[¥| Maynard, Susan

-[¥] McCullough, Scott

1]

oK ] [ Cancel

Figure 11 - Filter Values

3. Click the checkboxes to select/deselect values that you want to filter for.

Click OK to apply your filter.
5. Afilter icon will appear next to the drop-down arrow to indicate a filter has been applied to the

field.
Region Al -
Sum of No.ltems Column Labels v
Row Lahels .Y‘Famboo Coffee Table Bamboo End Table Captain Recliner Chameleon Couch
Arnold, Cole 154 104 138 121
Byrd, Asa 150 69 155 101
Grand Total 304 173 293 222

Figure 12 - Filter Applied

6. To remove the filter, click the drop-down arrow.
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7. The drop-down menu will appear. Click Clear Filter From to remove the filter.

8] SortAtoZ
Zl SortZtoA

Muore Sort Options..

IYX Clear Filter From "Salesperson” I
Label Filters 3

Walue Filters 4
Search el
¥i <[] (Select All) a
[l &rnold, Cole
[Vl Byrd, &sa
~[] Christensen, Jill
-] Kelly, Icelita
-] Leon, Emily
~[] livingston; Lynette
-] Lucas, John —
-] Maynard, Susan
~[IMcCullough, Scott L‘

| OK I Cancel I

Figure 13 - Clear Filter From

PivotCharts

Similar to PivotTables, PivotCharts can be used to quickly summarize, sort, filter, and analyze large
amounts of data, and display that data as a visual representation. After creating your PivotTable, you
can create a PivotChart using a variety of available charts (e.g. Pie, Line, Bar) that uses the same field
settings.

Creating PivotCharts

The following will show you how to create a PivotChart from an existing PivotTable:
1. Highlight the data you want to use for your PivotChart.
2. Inthe Ribbon, Click the Insert tab.

3 - R -
File Home Page Layout Formulas Data Review View Q' Tell me what you want to do...
3 | L?;'I' - ll'l-' |ll" [ |
7 B B LD LD @ ' RO g
PivotTable Recommended Table  Pictures Online 1M Add-i . Recommended PivotChart 3D
H ins DO
PivotTables Pictures @+ ™ Y I Charts L RSERg = Map ~
Tables INustrations Add-ins Charts | Tours

Figure 14 - Insert Tab
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3. Under the Charts grouping, click PivotChart.

View ¢ Tell me what you want to do...

1?

0| TRl I
Recommended I

Charts L AR >L<.

Charts

- - -
II I- |l'l

|

|

Figure 15 - PivotChart

4. The Create PivotChart window appears to allow you to change the data range, choose where

you want the PivotChart to be placed, and choose whether or not you want to analyze multiple

tables. Make your selections and click OK. In this example, a new worksheet will be created.

s

Create PivotChart

i@ Select a table or range

_ Use an external data source

Connection name:
Use this workbook's Data Model

@ Mew Worksheet
71 Existing Worksheet

Location: |

|:| Add this data to the Data Model

[ 2 [ |

Choose the data that you want to analyze

Table/Range:  ‘Creating a PivotChart'!SAS1:5H5910

Choose where you want the PivotChart to be placed

Choose whether you want to analyze multiple tables

Figure 16 - Create PivotChart Options
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5. The PivotChart will be placed into your workbook on a new worksheet.

To build a report, choose
fields from the PivotTable
Field List

=
BB 0@ o e W e

A

=
e

| i ]| v | [ — — | f—| PivotChart Fi b
{
Chart 1 | Choase fields to add b repork: -
wotChart, choose fields from the PreotChart Feld List + =
|
" - |
(] — '
= |
— |
|
Tirag fields between aress below
Y ALTERS 11! LEGENE) {SERIES)

= AXISICATEG.  Z VALUES

Figure 17 - New PivotChart Worksheet

6. The PivotChart Fields will appear on the right side of the screen.

PivotChart Fields v

Choose fields to add to report: =
Search Peol

Salesperson
Product
Region
Customer
Date

Itern Cost
Mo.Items
Total Cost

Drag fields between areas below:

FILTERS LEGEMD (SERIES)

AXIS (CATEG.. % VALUES

Figure 18 - PivotChart Fields

Note: You can alter the information that is displayed the same way as with PivotTables. See Analyzing
Data with PivotTables for more information.
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7. To change the chart type, click the chart and click the Change Chart Type in the Data grouping

on the Design tab.

Switch Row/ Select
Column Data

Data

Figure 19 - Change Chart Type

8. Click a Chart Type (see Figure 20).
9. Click the Chart Style you want to use (see Figure 20).

10. Click OK to save the selection (see Figure 20).

All Charts o~

™ Recent

9

o3 (|

18 #n 88 08 dd

Bar

Area

XY (Scatter)
Stock
Surface
Radar
Treemap
Sunburst
Histogram
Box & Whisker
Waterfall

FEREFOEARBEEEMGT

Combo

X Line Stacked Column

i0

OK

Cancel

Figure 20 - New Chart Selection
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Filtering the PivotChart

The following shows how to filter information within a PivotChart:

1. Next to a Field Header, click the drop-down arrow.

Region ¥
Sum of No.Items
1200
1000 I
800 . .
600 =
B | 0 g E = I g
400 = & ; :
R EEEREEEER
0
& RN S < & QO T Q
& 6‘7&’ é\*\’\ & & & F P & Q:o“\o
SIS > N A B R 3 A
S &N FH VT E RS s
< & N o N Q7 \O o 3
& & @ Yo
©
Salesperson Y@

Product b

= Media Armoire
Chameleon Couch

= Captain Recliner

8 Bamboo End Table

® Bamboo Coffee Table

Figure 21 - Drop-Down Button

2. A Drop-down menu will appear with values for the field listed below.

SortAtoZ

PN N
—

—

SertZto A

More Sort Options...

Label Filters

Value Filters

[Search

"V (Select All

-] Arnold, Cole

-[¥| Byrd, Asa

-[¥] Christensen, Jill
[ Kelly, Icelita

-[¥| Leon, Emily

¥ Livingston, Lynette
¥ Lucas, John

-] Maynard, Susan
¥ McCullough, Scott

>

-

[ ok

][ Cancel ]

Figure 22 - Filter Values

3. Click the checkboxes to select/deselect values that you want to filter for.

4. Click OK to apply your filter.
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5. Afilter icon will appear next to the drop-down arrow to indicate a filter has been applied to the
field.

Region ¥

Sum of No.Items

700
600
L] [ Product -

200 ' m Media Armoire
100 ‘ 1 Chameleon Couch
ROB m Captain Recliner
200 ® Bamboo End Table
100 B Bamboo Coffee Table

0

Arnold, Cole Byrd, Asa

Salesperson I -Y

6. To remove the filter, Click the drop-down arrow.
7. The drop-down menu will appear. click Clear Filter From to remove the filter.

Figure 23 - Filter Applied

—

SortAtoZ
SortZto A

DN N
s

More Sort Options..,

IYX Clear Filter From "Salesperson” l
Label Filters 4

Walue Filters

v

(Search

Ve (Select Al
- Arnold, Cole
-] Byrd, Asa
-] Christensen, Jill
-] Kelly, Icelita
~[ILleon, Emily
-] Livingston, Lynette
~[Jlucas, John =
-1 Maynard, Susan

E T»-:‘IcCuIIouEI.q, Scott LI

| QK I Cancel I

Figure 24 - Clear Filter From

I* %
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Using Slicers to Filter Data

Slicers can provide greater control over your PivotTable or PivotChart when you are analyzing your
data. Slicers work similar to filtering your information, but allows you to insert tables that you can use
to quickly select values to filter/unfilter. They will show what is currently shown/not shown at a glance.
Slicers can also be adjusted to change their size and color to make them more presentable.

Inserting Slicers into your PivotTable or PivotChart
The following explains how to insert Slicers into your PivotTable:
1. Click within your PivotTable to select it.
2. Inthe Ribbon, Click the Insert tab.

H ©- v B =
File Home Page Layout Formulas Data Review View Q Tell me what you want to do...
C - = (RN SR | ] R fiss)
B LD d 2 e A [T R TP T ]
H = = ' L || T -
PivotTable Recommended Table  Pictures Online _ &My Add-ins - E Recommended Do \L_I" PivotChart 30 Line Column Win/  Slicer Timeline Hyperlink
PivotTables Pictures @i+ Chars = =] o Map - Loss
Tahbles Illustrations Add-ins Charts ' Tours Sparklines Filters Links

Figure 25 - Insert Tab

3. Under the Filters grouping, click Slicer.

F

=

Slicer fTimeline

Filters

Figure 26 — Slicer

4. The Insert Slicers window will appear with a list of your available fields.

=

Insert Slicers

||salesperson
[ ]Product
[]Region

[] Customer
[]Date
[]Hitem Cost
[[MNo.tems
[]Total Cost

Figure 27 - Insert Slicers Window

5. Click the checkboxes next to the field(s) you want to create slicers for.
6. Click OK.
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7. The slicers will be inserted into your spreadsheet.

Salesperson

|
Arnold, Cole 1= ‘ ‘

: Byrd, ‘l Product

Christ'; | Bamboo Coffee Table

Keily,j ' Bamb Region

| Leon, | [ captal | NE

S|

| Living! | cham{ | nw

| Lucas, | Mediz | sE

L Maynara; susar ‘ SW

Figure 28 - Slicers Inserted

8. Click and drag the slicers to reposition them as necessary.
9. To apply a filter from one of the slicers, click one of the values.

Salesperson

qArnold, Cole | 2

: Byrd, Asa

Christensen, Jill

m

Kelly, Icelita

Leon, Emily

| Livingston, Lynette
Lucas, John

: Maynard, Susan

Figure 29 - Using a Slicer

Note: To select multiple values, hold down the shift key while clicking your values.

10. To remove values from your slicer, click the Clear Filter icon in the upper-right hand corner of
the slicer.

Salesperson 9%&
i V'S

: Arnold, Cole
Byrd, Asa
Christensen, lill
Kelly, lcelita

Leon, Emily

Livingston, Lynette
Lucas, John

Maynard, Susan _I
v

Figure 30 - Clear Filter from Slicer
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Additional Slicer Options

When a Slicer is selected, the Slicer Tools — Options tab will be available in the Ribbon. From this tab,
you can change the Slicer caption, style, and size of the buttons and window. The following explains

how to access the Slicer Tools — Options tab:

1. Click the Slicer.
2. Inthe Ribbon, click the Slicer Tools — Options tab.

Slicer Tools

@ Tell mewhat you want to do...

Review Wiew

File Home [nsert Page Layout Formulaz Data
Slicer Caption: =7 =] === == == === [==] == 3 (- ‘B Columns: |1 -l & . .
R "?_)ﬂ = BV Ve B 0V = =T ol ] On e £ regne 025 ¥ Height: |2.75
ion === === == == == =2 E== |- : sightz |02 .
= = Feport oo 222 222 EEE EEE EEE EEEL . Ering Send  Selection Align Group Rotote L _g . | = Widthe (2
[E] Shieer Setings  Connections Forward - Backward ©  Pane = eos Width: 181 .
Elicer Slicer Styles Arrange Buttons Size ]

Figure 31 - Slicer Tools - Options Tab

3. Additional Slicer tools will be displayed. From here you can alter the slicer captions, styles,

button, and window size.

.1Bring Forward ~ |(=_ -

‘B Columns: |1

Slicer Caption: = ==l === —— == [ == == I T . .

: \L;‘EI _ i e B e B = = e £ [ Height: |2.76 -
Region o === == I==—=I|} I E== === === === |===] ~ 0 Send Backward - 3__|:|HE|ght: 0.26" .

eport ——C 22222 222 EEE EEE) 222 EEE] . —| = . |an -

(] Slicer Settings  Conmections % Ci; Selection Pane S Width: 181" G [ -

Slicer Slicer Styles Arrange Buttons Size P

Figure 32 - Additional Slicer Tools

Additional Help

For additional support, please contact the KSU Service Desk:

KSU Service Desk for Faculty & Staff

e Phone: 470-578-6999
e Email: service@kennesaw.edu
e Website: http://uits.kennesaw.edu

KSU Student Helpdesk

e Phone: 470-578-3555
e Email: studenthelpdesk@kennesaw.edu
e Website: http://uits.kennesaw.edu
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